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Safety Information 

 

 

 

The CY4521 EZ-PD™ CCG2 EVK is intended for use as a development platform for hardware or software in a laboratory 
environment. The board is an open-system design, which does not include a shielded enclosure. Due to this reason, the 
board may cause interference to other electrical or electronic devices in close proximity. In such cases, take adequate 
preventive measures. Also, do not use this board near any medical equipment or RF devices.  

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its 
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable 
mitigating measures must be taken.  

The CY4521 EZ-PD CCG2 EVK as shipped from the factory has been verified to meet with requirements of CE as a Class A 
product. 

 

 

 

The CY4521 EZ-PD CCG2 Evaluation Kit boards contain ESD-sensitive devices. Electrostatic 
charges readily accumulate on the human body and any equipment, which can cause a discharge 
without detection. Permanent damage may occur to devices subjected to high-energy discharges. 
Proper ESD precautions are recommended to avoid performance degradation or loss of functionality. 
Store unused CY4521 EZ-PD CCG2 Evaluation Ki  boards in the protective shipping package. 

 

End-of-Life/Product Recycling 

The end-of-life cycle for this kit is five years from the date of manufacture mentioned on the back of 
the box. Contact the nearest recycler to discard the kit. 
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General Safety Instructions 

ESD Protection  

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an 
ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap 
attached to the chassis ground (any unpainted metal surface) on the board when handling parts. 

Handling Boards 

The boards provided with CY4521 EZ-PD CCG2 Evaluation Kit are sensitive to ESD. This also applies to the boards that are 
provided with a plastic casing when they are removed from the casing. Hold the boards only by the edges. After removing a 
board from the box/casing, place it on a grounded, static-free surface. Use a conductive foam pad, if available. Do not slide 
the board over any surface. 
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1.   Introduction 

 

 

The CY4521 EZ-PD™ CCG2 Evaluation Kit (EVK) is based on the CCG2 product family of Cypress’s USB Type-C 
microcontrollers. This EVK is primarily intended to be an evaluation vehicle for USB Type-C host and client systems that 
house a Type-C connector as well as for notebook applications. For USB Power Delivery (PD), the base board and daughter 
card can be configured as a downstream facing port (DFP) or an upstream facing port (UFP). The kit also serves as a platform 
to evaluate other features of Type-C such as SuperSpeed USB and DisplayPort data transfer.  

1.1   Kit Contents 

The CY4521 EZ-PD CCG2 EVK consists of the following contents: 

 CCG EVK Base Board 

 CY4521 CCG2 Daughter Card (mounted on the CCG EVK Base Board) 

 24-V DC 65 W Power Adapter (24 V, 2.7 A) 

 USB 3.0 Type-A to Type-B cable 

 USB Type-C to Type-A adapter 

 USB 2.0 Type-A to Mini-B Cable 

 Quick Start Guide 

1.1.1   Hardware Not Included With Kit 

The CY4521 EZ-PD CCG2 EVK does not come with all of the hardware needed to perform the demonstrations documented 
in sections SuperSpeed USB Demo, DisplayPort Demo, SuperSpeed USB and DisplayPort Demo and Dead Battery Demo 
of the Kit Operation chapter. The following items are not included: 

 SuperSpeed USB flash drive needed for the SuperSpeed USB Demo section. 

 DisplayPort cables needed for the DisplayPort Demo section. They are required to make connections from a PC to the 
CCG EVK base board. If the PC has a mini-DisplayPort, then a mini-DisplayPort to DisplayPort cable will be required. If 
the PC has a DisplayPort, then a DisplayPort to DisplayPort cable will be required. Recommended cables are listed in 
Recommended Cables and Adapters section. 

 USB Type-C to DP/HDMI/VGA adapter and USB Type-C Multiport Adapter to connect a display monitor and a USB flash 
drive to the CY4521 EZ-PD CCG2 EVK. Recommended adapters and cables needed for them to connect to monitors 
are listed in Recommended Cables and Adapters section. 
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 A digital multimeter to measure voltage for the Dead Battery Demo section. A standard multimeter is required to measure 
the output voltage on the CCG EVK base board. 

 A USB Type-C Power Adapter for the Dead Battery Demo section 

1.2   Getting Started 

For instructions on how to run a quick demonstration and observe kit functionality, refer to the SuperSpeed USB Demo section. 
That section also provides complete instructions on configuring the CCG EVK base board and CY4521 CCG2 daughter card. 

1.3   List of Recommended Hardware 

1.3.1   Recommended Cables and Adapters 

See Table 1-1 to obtain a set of cables recommended to work with this kit – the cables that you need will depend on the 
hardware you are connecting to the kit (i.e. the PC display output type and the monitor input type). This kit is not shipped with 
these cables and adapters and they are required to run the DisplayPort Demo and Dead Battery Demo. 

Table 1-1. List of Recommended Cables and Adapters 

No. Description For Hardware Manufacturer MPN Vendor Link 

1 DisplayPort to DisplayPort Cable (6”, gold 
plated) 

PC with DisplayPort Cable Matters 102005-6 Amazon Link 

2 Mini DisplayPort to DisplayPort Cable (3”, 
gold plated) 

PC with Mini DisplayPort Cable Matters 101007-BLACK-3 Amazon Link 

3 Type-C to Display Port Adapter Monitor with DisplayPort Belinda - Amazon Link 

4 Type-C to HDMI Adapter Monitor with HDMI Cable Matters - Amazon Link 

5 Type-C to VGA Adapter Monitor with VGA Cable Matters - Amazon Link 

6 Type-C Power Adapter that supports 9V or 
above 

All Apple - Apple Store 
Link 
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Type-C Multiport Adapter 

Monitor with HDMI and USB 
SuperSpeed flash drive 

Apple 

 

- Apple Store 
Link 

Monitor with VGA and USB 
SuperSpeed flash drive 

Apple  Apple Store 
Link 

Monitor with HDMI and USB 
SuperSpeed flash drive 

Samsung - Amazon Link 

 

Use item 1 or 2 in Table 1-1 to connect the PC’s DisplayPort or Mini-DisplayPort to the DisplayPort of CY4521 EZ-PD CCG2 
EVK. Depending on the display monitor you have, use item 3, 4 or 5 in Table 1-1 to connect from the USB Type-C port of the 
CY4521 EZ-PD CCG2 EVK to the display monitor itself. Use item 6 to run the Dead Battery Demo. 

1.4   Acronyms 

Table 1-2. Acronyms Used in this Document 

Acronym Definition 

ADC Analog-to-Digital Converter 

CC Configuration Channel 

CCG Cable Controller Generation 

DFP Downstream Facing Port 

DP DisplayPort 

DRP Dual Role Port 

http://www.amazon.com/gp/product/B005H3Q59U/ref=ox_sc_act_title_1?ie=UTF8&psc=1&smid=A1AMUYYA3CT6HJhttp://www.amazon.com/gp/product/B005H3Q59U/ref=ox_sc_act_title_1?ie=UTF8&psc=1&smid=A1AMUYYA3CT6HJ
http://www.amazon.com/Cable-Matters-DisplayPort-Thunderbolt-Compatible/dp/B00C7RIL3C/ref=pd_sim_pc_6?ie=UTF8&refRID=1QEH8T0R161NKW108VSJ
http://www.amazon.com/Belinda%C2%AEUSB-DisplayPort-Adapter-Aluminium-ChromeBook/dp/B0155APCN4
http://www.amazon.com/Cable-Matters-Adapter-Supporting-Resolution/dp/B00X4S5C7G
http://www.amazon.co.uk/Cable-Matters%C2%AE-USB-C-Adapter-Black/dp/B00X4S58LQ
http://www.apple.com/shop/product/MJ262LL/A/apple-29w-usb-c-power-adapter
http://www.apple.com/shop/product/MJ262LL/A/apple-29w-usb-c-power-adapter
http://www.apple.com/shop/product/MJ1K2AM/A/usb-c-digital-av-multiport-adapter
http://www.apple.com/shop/product/MJ1K2AM/A/usb-c-digital-av-multiport-adapter
http://www.apple.com/shop/product/MJ1L2AM/A/usb-c-vga-multiport-adapter?fnode=2624a9218662a2b6a919863dbec97e4affc5f746637174b32e5b734f7c41ec002e9b3221741eaa26f3eb84859cd402a48997196e4bb161dd010589e2b93b20a916ab026c68a463313515c874b8b65b1f4ff0db9723b2c31c276142b0aafbb38784d2d829fa348cdec71f991a08471640
http://www.apple.com/shop/product/MJ1L2AM/A/usb-c-vga-multiport-adapter?fnode=2624a9218662a2b6a919863dbec97e4affc5f746637174b32e5b734f7c41ec002e9b3221741eaa26f3eb84859cd402a48997196e4bb161dd010589e2b93b20a916ab026c68a463313515c874b8b65b1f4ff0db9723b2c31c276142b0aafbb38784d2d829fa348cdec71f991a08471640
https://www.amazon.com/Samsung-EE-PW700BWEGUJ-Multiport-Adapter/dp/B01DN09RYI/ref=pd_sim_147_1?ie=UTF8&dpID=31LYrZGwBPL&dpSrc=sims&preST=_AC_UL160_SR160%2C160_&psc=1&refRID=GGY96B3ZJ7W722MT7QJX
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Acronym Definition 

EC Embedded Controller 

EMCA Electronically Marked Cable Assembly 

EMI Electromagnetic Interference 

ESD Electrostatic Discharge 

EVK Evaluation Kit 

FET Field-Effect Transistor 

GPIO General-Purpose Input/Output 

HID Human Interface Device 

HPD Hot Plug Detect 

IC Integrated Circuit 

I2C Inter-Integrated Circuit 

IDE Integrated Development Environment 

LED Light-Emitting Diode 

PMIC Power Management Integrated Circuit 

PS Power Supply 

PSoC
®

 
Programmable Systems-on-Chip 

PWM Pulse-Width Modulation 

QFN Quad Flat No-lead (package) 

SS SuperSpeed 

SWD Serial Wire Debug 

UART Universal Asynchronous Receiver Transmitter 

UFP Upstream Facing Port 

USB Universal Serial Bus 

USB-PD Universal Serial Bus Power Delivery 

XRES External Reset I/O Pin 
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2.   Kit Installation 

 

 

This chapter describes the procedure to install the CY4521 EZ-PD CCG2 EVK software.  

2.1   CY4521 EZ-PD™ CCG2 EVK Kit Software Installation 

To install the kit software, follow these steps: 

a. Download the latest kit software setup file “CY4521 EZ-PD CCG2 EVK Complete Setup” from the kit’s website: 
www.cypress.com/CY4521. This package contains the kit hardware files, firmware binaries and the kit documentation 
(User Guide, Quick Start Guide, and Release Notes). Double-click on the executable to start the installation. Click Next 

when the screen shown in Figure 2-1 appears. 

Figure 2-1. CY4521 EZ-PD CCG2 EVK Installer Screen 

 

 

b. Select the required Installation Type and click Next to start the install (Figure 2-2). For first-time installation, it is 
recommended that you select “Typical” as the Installation Type. 

 

 

 

 

http://www.cypress.com/CY4521
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Figure 2-2. Installation Wizard 

 

 

c. Accept the license agreement for the software components and click Next (Figure 2-3). 

Figure 2-3. License Agreement 
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d. Figure 2-4 shows the installation progress. 

Figure 2-4. Installation Progress 

 

 

e. Enter Contact Information or select Continue Without Contact Information and click Finish. (Figure 2-5). 

Figure 2-5. Software Installation Complete 
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f. When installation is complete, you have the option to Launch Cypress Update Manager (Figure 2-6) to ensure you 
have the latest software package. Click the Check for updates button at the bottom of the window. If “No Updates” 
appears adjacent to the CY4521 EZ-PD CCG2 EVK, click the Exit button. If there are updates, click the Update button 

to download and install the latest kit package. 

Figure 2-6. Cypress Update Manager 

 

 

Note: You can launch the Cypress Update Manager at any time from Start > All Programs > Cypress > Cypress 
Update Manager. 

g. After the installation is complete, the contents are available at the following location: <Install Directory>\CY4521 
EZ-PD CCG2 EVK\1.0. 

Note: On the Windows 32-bit platform, the default <Install Directory> is C:\Program Files\Cypress; on the Windows 

64-bit platform, it is C:\Program Files(x86)\Cypress. 
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3.   CY4521 EZ-PD™ CCG2 EVK Hardware 
Details 

 

The CY4521 EZ-PD CCG2 EVK consists of a CCG EVK base board and a CCG2 daughter card. The CCG2 device is mounted 
on the daughter card, which is connected to the base board. The hardware architecture of CY4521 is captured in Figure 3-1. 

Figure 3-1: CY4521 EZ-PD CCG2 EVK Architecture 
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The CCG EVK base board consists of a DC input, a USB Type-C Redriving Switch IC, a DisplayPort input, a SuperSpeed 
Type-B port, and one Type-C port. The CCG2 daughter card consists of the CCG2 device and a USB-Serial IC to provide a 
USB interface for debugging and programming. The CC lines of the CCG2 device are connected to the Type-C port. The USB 
Type-C Redriving Switch IC is controlled by the CCG2 device over an I2C interface. 

The CY4521 EZ-PD CCG2 EVK has power provider and consumer path control circuitry to showcase EZ-PD CCG2’s ability 
to switch its power role from a provider to a consumer and vice versa. This EVK has over-voltage and over-current protection 
circuitry for VBUS and it also supports programming of the EZ-PD CCG2 device over SWD and I2C interfaces. The EVK 
supports PCs, notebooks, tablets, and other applications that would host a Type-C interface. It is primarily intended as an 
evaluation vehicle for USB host systems that house a Type-C connector.  

  



   CY4521 EZ-PD™ CCG2 EVK Hardware Details 

CY4521 EZ-PD™ CCG2 Evaluation Kit Guide, Doc. No. 002-15712 Rev. *A 15 

3.1   CCG EVK Base Board 

The CCG EVK base board is an evaluation board equipped with a Type-C port, a SuperSpeed USB Type-B port, and a 
DisplayPort interface. It is primarily intended as a demonstration board for notebook designs that house a Type-C connector. 
The board also serves as a vehicle to evaluate the alternate modes for Type-C, using the DisplayPort demo as an example.  

3.1.1   Block Diagram 

The block diagram of the CCG EVK Base board is shown in Figure 3-2. It has an on-board Type-C connector for the USB-
PD interface and a daughter card interface connector to connect the CCG2 daughter card. It also includes a SuperSpeed 
USB Type-B port, and a Display Port connector to source video. The SuperSpeed USB signals and Display Port signals are 
connected to the Type-C connector through a USB Type-C Redriving Switch controlled by the CCG2 device. A DC power 
adapter provides input voltage to the onboard Power Management IC (PMIC). The output voltage from the PMIC can be 
selected using two voltage selection lines, controlled by the CCG2 device. This CCG EVK base board along with the CCG2 
daughter card helps to convert any desktop or notebook PC with legacy USB ports to operate as a Type-C USB host. 

Figure 3-2: CCG EVK Base Board Block Diagram 
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3.1.2   Features 

Table 3-1 shows the features of the CCG EVK base board. 

Table 3-1: CCG EVK Base Board Features 

Feature Description 

Power 

The 24V input provided to the hardware is converted into the voltage to be provided on 
the Type-C port using a PMIC. The output voltage of the PMIC is controlled by CCG2. 
Power can also be consumed from Type-C connector for dead battery functionality.  

Note: The DC power adapter provided with the kit can support only up to 2.7A (at 24 V). 

This kit will not work with 5V DC power adapters. 

CCG2 Daughter Card 
Interface Connector 

Provides interface to connect the CCG2 daughter card to the CCG EVK base board 

Type-C Plug orientation, 
Detection and Alternate 
modes 

I2C interface between the CCG2 device and the USB Type-C Redriving Switch to select 
between ‘SuperSpeed USB and 2-lane DisplayPort or ‘4-lane DisplayPort’ combinations 

Hot Plug Detect (HPD) for Display Port Alternate Mode operation 
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3.1.3   Connectors and Jumper Settings 

Figure 3-3 shows the CCG EVK base board connectors and default settings of the jumpers. Table 3-2 contains the detailed 
description of the connectors and jumper settings. 

Figure 3-3: CCG EVK Base Board Connectors 

 

 

Table 3-2: CCG EVK Base Board Connector/Jumper Description 

Connector/Jumper Description Default 

J1 24V DC power jack to connect the DC power adapter to the CCG EVK base board NA 

J2 SuperSpeed USB Type-B connector (receptacle) NA 

J3 USB Type-C Connector (receptacle) NA 

J4 DisplayPort Connector NA 

J5 
USB 2.0 Mini-B Connector (receptacle) 

 
NA 
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Connector/Jumper Description Default 

J6 USB Serial Debug Header 
This connector 
is not populated 

J7 Header for voltage measurement when CCG2 acts as a power consumer or power output header NA 

J8 

CY4521 CCG2 Daughter Card Interface Connector 

NA 

Pin 1,2: Regulated input power from 24-VDC terminal (J12) of CCG EVK Base Board 
(USB_P_PWR) 

Pin 3,4: Power from VBUS of Type-C Connector (Type-C_VBUS) 

Pin 5,6: Regulated output power to 20-Vdc terminal (J7) from  USB_C_PWR pin of CCG2 
daughter card 

Pin 7: GND Pin 8: GND 

Pin 9: I2C_SCL Pin 10: VBUS_DISCHRG 

Pin 11: I2C_SDA Pin 12: CCGx SWDIO 

Pin 13: Over Current Protection Pin Pin 14: CCGx SWD_CLK 

Pin 15: AC_Adapter_Detect Pin 16: CCGx XRES 

Pin 17: VSEL2 Pin 18: I2C_ADDR0 

Pin 19: 5 V Pin 20: VCONN Monitor 

Pin 21: CC1 Pin 22: CC2 

Pin 23: 3.3 V Pin 24: VBUS_P_CTRL 

Pin 25: RXD Pin 26: VBUS Monitor 

Pin 27: TXD Pin 28: I2C_INT_EC 

Pin 29: MUX_DP_AUXN Pin 30: VBUS_C_CTRL 

Pin 31: MUX_DP_AUXP Pin 32: Over Voltage Protection Pin 

Pin 33: SBU2 Pin 34: I2C_SDA_EC 

Pin 35: SBU1 Pin 36: Hotplug Detect 

Pin 37: I2C_SCL_EC Pin 38: TP12 

Pin 39: VSEL1 Pin 40: TP11 

J9 

Debug Connector 

NA 

Pin 1,2: Power from VBUS of Type-C Connector (Type-C_VBUS) 

Pin 3: CCGx SWDIO Pin 4: CCGx XRES 

Pin 5: CCGx CC1 Pin 6: CCGx CC2 

Pin 7: I2C_SCL_EC Pin 8: I2C_SDA_EC 

Pin 9: I2C_INT_EC Pin 10: Hotplug Detect 

Pin 11: I2C_SCL Pin 12: SW1/I2C_SDA 

Pin 13: SW2 Pin 14: Over Current Protection Pin 

Pin 15: CCGx SWD_CLK Pin 16: Over Voltage Protection Pin 

Pin 17: VSEL1 Pin 18: VSEL2 

Pin 19: VBUS_P_CTRL Pin 20: VBUS_DISCHRG 

Pin 21: VBUS_Monitor GPIO Pin 22: VBUS_C_CTRL 

Pin 23: GND Pin 24: GND 

J10 

I2C Connector 

This connector 
is not populated 

Pin 1: I2C_SDA_EC Pin 2: I2C_SCL_EC 

Pin 3: I2C_INT_EC Pin 4: GND 

J11 

User LED jumper for connecting LED to GPIO 

Pin 1: SWD_IO 

Pin 2: LED 

Shorted 

J12 Header for voltage measurement when CCG2 acts as a power provider or power input header. NA 



   CY4521 EZ-PD™ CCG2 EVK Hardware Details 

CY4521 EZ-PD™ CCG2 Evaluation Kit Guide, Doc. No. 002-15712 Rev. *A 18 

3.2   CY4521 CCG2 Daughter Card 

The CCG2 daughter card is equipped with the CYPD2122-24LQXIT of the CCG2 device family and a CY7C65215-32LTXI 
USB-Serial Bridge Controller to provide a USB interface for debugging and programming. This CCG2 daughter card, when 
assembled with the CCG EVK base board supports Type-C host applications such as notebooks and tablets.  

3.2.1   Block Diagram 

Figure 3-4 shows the CCG2 daughter card block diagram. 

Figure 3-4 CCG2 Daughter Card Block Diagram 
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3.2.2   Features 

Table 3-3 lists the features of the CCG2 daughter card. 

Table 3-3: CCG2 Daughter Card Features 

Feature Description 

CCG2 part number CYPD2122-24LQXIT 

CCG2 package 24-pin QFN 

USB PD/ Type-C 

Ability to support DRP, DFP, and UFP 

Type-C VBUS current setting via a jumper that selects one of the three Rp values. These three values 
correspond to the three currents as defined in the Type-C specification. 

VBUS provider field-effect transistor (FET) control for cold socket 

VBUS consumer FET control 

VBUS discharge FET control  

Ability to present either Rd or Rp on CC line 

Dead battery support 

OVP and OCP 
VCONN or VBUS over-current protection 

VBUS over-voltage protection 

Plug orientation, Detection and 
Alternate modes 

Five MUX-select pins to select between SuperSpeed USB and 2-lane or 4-lane DisplayPort 

Hot Plug Detect (HPD) for DisplayPort Alternate Mode of operation 

USB 2.0 Type-B Mini USB 2.0 Mini-B receptacle connected to USB-to-Serial device 

I2C interface I2C pins and interrupt output pin for connecting to an Embedded Controller (EC)  

Programming SWD pins to debug/program CCG2 using Cypress MiniProg3 

http://www.cypress.com/?rID=38154
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Feature Description 

Power 

5 V from USB 2.0 Mini B (Connector J5 of CY4521 CCG2 daughter card) 

5 V from MiniProg3 (Connector J1 of CY4521 CCG2 daughter card) 

3.3 V/ 5 V power supply from the CCG EVK base board 

3.2.3   Connectors and Jumper Settings 

Figure 3-5 shows the CCG2 daughter card connectors and default settings of the jumpers. Table 3-4 contains the detailed 
description of the connectors and jumper settings. 

Figure 3-5: CCG2 Daughter Card Connectors/Jumper Settings 
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Table 3-4: CCG2 Daughter Card Connector/Jumper Description 

Connector/Jumper Description Default 

J1 

Programming header 

Pin 1: VTARG 

Pin 2: GND 

Pin3: CCG2_XRES 

Pin4: CCG2_SWD_CLK 

Pin5: CCG2_SWD_IO 

NA 

J2 

VSYS selection jumper: 

1 and 2 short: Select the power from 3.3-V supply coming from the CCG EVK base board 

2 and 3 short: Select the power from 5-V buck regulator of the CCG EVK base board 

1 and 2 short 

J3 

I/O supply selection jumper: 

1 and 2 short: Select the power from VSYS of CCG2 device 

2 and 3 short: Select the power from VDDD of CCG2 device 

2 and 3 short 

J4 

CCG Base Board Interface Connector 

NA 

Pin 1,2: Regulated input power from 24-VDC terminal (J12) of the CCG EVK Base Board  
(USB_P_PWR_P1) 

Pin 3,4: Power from VBUS of Type-C Connector of the CCG EVK Base Board (TYPE-
C_VBUS_P1)  

Pin 5,6: Regulated output power to 20-VDC terminal (J7) of the CCG EVK Base Board 
(USB_C_PWR_P1) 

Pin 7: GND Pin 8: GND 

Pin 9: I2C_SCL Pin 10: VBUS_DISCHRG_P1 

Pin 11: I2C_SDA Pin 12: SWDIO 

Pin 13: USB Provider Power Sense Pin Pin 14: SWD_CLK 

Pin 15: AC_Adapter_Detect Pin 16: XRES 

Pin 17: VSEL2 Pin 18: UART2_RX 

Pin 19: 5 V Pin 20: UART2_TX 

Pin 21: CC1 Pin 22: CC2 

Pin 23: 3.3 V Pin 24: VBUS_P_CTRL0 

Pin 25: TXD Pin 26: VCONN 

Pin 27: RXD Pin 28: I2C_INT_EC 

Pin 29: DP_AUXN_P1 Pin 30: VBUS_C_CTRL0 

Pin 31: DP_AUXP_P1 Pin 32: GPIO/P2.4 

Pin 33: SBU2 Pin 34: I2C_SDA_EC 

Pin 35: SBU1 Pin 36: Hotplug Detect 

Pin 37: I2C_SCL_EC Pin 38: DPlus 

Pin 39: VSEL1 Pin 40: DMinus 

J5 
USB 2.0 Mini-B connector (receptacle) 

Connected to USB-Serial device and used for programming CCG2 device 
NA 
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3.3   Powering the CY4521 EZ-PD CCG2 EVK Setup 

The CY4521 EZ-PD CCG2 EVK setup can be powered by connecting the 24-V DC power adapter to connector J1 of the CCG 
EVK base board. LED1 on the CCG EVK base board and LED2 on CCG2 daughter card board will glow green and LED2 on 
the CCG EVK base board will blink orange continuously, to indicate a successful power connection. The CY4521 EZ-PD 
CCG2 EVK setup can also be powered by connecting 24-V DC from a variable power supply to the terminals of connector 
J12 of the CCG EVK base board. 

Note: Check the jumper positions before you power the board. See Figure 3-3 and Figure 3-5 for default jumper settings of 

the CCG EVK base board and CCG2 daughter card. 
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4.   Programming the EZ-PD™ CCG2 Device 
on the CY4521 

 

 

The CCG2 device in the CY4521 EZ-PD CCG2 EVK is pre-programmed with the latest cyacd firmware binary image at the 
time of manufacturing. However, a newer cyacd file may be available on the CY4521 EZ-PD CCG2 EVK webpage and in the 
CY4521 EZ-PD CCG2 EVK installer. The firmware version of the onboard CCG2 device can be verified by using the EZ-PD 
Configuration Utility as shown in Figure 4-4. If the onboard CCG2 device’s firmware version does not match with the latest 
version on the CY4521 EZ-PD CCG2 EVK webpage, follow the steps in this chapter to reprogram the CCG2 device. Device 
configuration parameters (such as vendor ID, Power Data Objects (PDOs), and DisplayPort Mode) can be updated using the 
EZ-PD Configuration Utility. Refer to the EZ-PD Configuration Utility User Manual for more details. 

The CCGx Software Development Kit (SDK) (version 3.0 or later) along with PSoC® Creator™ (version 3.3 SP2 or later) 
allows users to harness the capabilities of Cypress’s CCG families of Type-C Controllers. It provides a Type-C and USB-PD 
specification compliant firmware stack along with the necessary drivers and software interfaces required to implement 
applications using CCG controllers. The CCGx SDK also includes reference projects implementing standard Type-C 
applications and documentation that guides users in customizing existing applications, or creating new ones. For more 
information on the CCGx SDK, refer to the CCGx SDK User Guide. Click here to go to the CCGx SDK webpage and download 
and install the latest version. 

4.1   Programming the CCG2 Device on the CCG2 Daughter Card 

CCG2 firmware build design uses a two .cyacd file approach. The first .cyacd file is the firmware image and the second .cyacd 
file is the configuration data file. The EZ-PD Configuration Utility is a Windows Application, which can be used to configure 
and program the CCG2 device on the CCG2 daughter card. The steps to update the firmware running on the CCG2 device 
of the CCG2 daughter card are as follows: 

1. Download and install the latest kit software setup file “CY4521 EZ-PD CCG2 EVK Complete Setup” from the kit’s 
website: www.cypress.com/CY4521. This installs the EZ-PD Configuration Utility as well. 

2. Ensure that the voltage selection jumper (J2) is set to 5 V (pins 2 and 3 of jumper J2 on the CCG2 daughter card are 
shorted). Note that this is NOT the default setting for this jumper. Also, ensure that the I/O supply selection jumper 
(J3) is set to VDDD of the CCG2 device (pins 2 and 3 of jumper J3 on the CCG2 daughter card are shorted). 

3. Connect the USB Type-A to Mini-B cable from the host PC to the CCG2 daughter card’s J5 connector as shown in 
Figure 4-1.  

http://www.cypress.com/CY4521
http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility
http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility
http://www.cypress.com/CY4521
http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility
http://www.cypress.com/file/183686/download
http://www.cypress.com/EZ-PDSDK
https://www.cypress.com/file/283636/download
http://www.cypress.com/EZ-PDSDK
http://www.cypress.com/CY4521
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Figure 4-1: Programming CCG2 Device on CY4521 EZ-PD CCG2 EVK 
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4. Launch the EZ-PD Configuration Utility as shown in Figure 4-2. After the installation, the EZ-PD Configuration Utility 

is available at the following location by default: 

Windows > Start > All Programs > Cypress > EZ-PD Configuration Utility > EZ-PD 

Configuration Utility 

Figure 4-2: EZ-PD Configuration Utility 
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5. Select Tools > Firmware Update to update the firmware of the CCG2 device as shown in Figure 4-3. Refer to the 

EZ-PD Configuration Utility User Manual for more details. That document can also be opened by clicking Help > 

User Manual in the EZ-PD Configuration Utility. 

Figure 4-3: Upgrading CCG2 Firmware 

 

  

6. Download the latest firmware images from the CY4521 EZ-PD CCG2 EVK webpage. The CCG2 device firmware is 

provided in .cyacd format. Sample firmware binary for each application and standard part numbers are provided on 

the CY4521 EZ-PD CCG2 EVK webpage. The firmware image is also available at the following location after the 

CY4521 EZ-PD CCG2 EVK installation: <Install_Directory>\CY4521 EZ-PD CCG2 EVK\1.0\Firmware 

7. Select NOTEBOOK from the Select target list shown in Figure 4-4. Click the button located in the Firmware path 

1 widget and select the FW image (CYPD2122-24LQXIT_notebook_x_x_x_xxx*_0_0_0_FW.cyacd).  

Note *: x_x_x_xxx refers to the firmware version. 

http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility?source=search&cat=software_tools
http://www.cypress.com/CY4521
http://www.cypress.com/CY4521
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Figure 4-4: Updating Firmware Using EZ-PD Configuration Utility 

 

 

8. Upon clicking Program, the firmware update process is initiated over I2C. The status bar at the bottom of the utility 

will show the progress; the Messages window will indicate the firmware update process. 

Warning: Do not disconnect the EVK from the PC while the firmware update is in progress.  

9. Upon successful completion of the firmware update process, a window  with the message “Firmware update 

succeeded” is displayed as shown in Figure 4-5. Click OK. 

Figure 4-5: Firmware Update Process Complete 

 

 

10. The above steps update the firmware image of the CCG2 device. In order to update the configuration data of the 

CCG2 device, select File > Read from Device as shown in Figure 4-6  to read the existing configuration data. 

Select Notebook and click on Read button. 
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Figure 4-6. Read Configuration Data from Device using EZ-PD Configuration Utility 

 
 

11. After reading the configuration data from the device, the EZ-PD Configuration Utility window looks similar to the 

screenshot shown in Figure 4-7. 
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Figure 4-7. Configuration Data of the CCG2 Device 

 
 

12. Click on File > Save As as shown in Figure 4-8 in order to save the read configuration data from the CCG2 device.  

This step is a pre-requisite to download the configuration data which is available at the following location after the 

CY4521 EZ-PD CCG2 EVK installation: <Install_Directory>\CY4521 EZ-PD CCG2 EVK\1.0\Firmware 
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Figure 4-8. Saving the Read Configuration File Using EZ-PD Configuration Utility 

 

 

13. Click on Tools > Configure Device as shown in Figure 4-9 to update the device configuration. 
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Figure 4-9. Updating CCG2 Device Configuration Using EZ-PD Configuration Utility 

 

 

14. In the new window that opens as shown in Figure 4-10, select NOTEBOOK from the Select target list shown in 

Figure 4-4. Click the button located in the Configuration File widget and select the configuration file (CYPD2122-

24LQXIT_notebook_x_x_x_xxx*_0_0_0_Config.cyacd). 
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Figure 4-10. Updating CCG2 Device Configuration 

 

 

15. Upon clicking Program, the configuration update process is initiated over I2C. The status bar at the bottom of the 

utility will show the progress; the Messages window will indicate the update process. 

 

Warning: Do not disconnect the EVK from the PC while the configuration update is in progress. 

 

16. Once the configuration update is over, a window with the message “Flashing Configuration Succeeded” is 

displayed as shown in Figure 4-11. Click OK. This successfully completes of the configuration update process.  

Figure 4-11. Configuration Update Process Complete 

 
 

17. Press switch SW1 (XRES) on the CCG2 daughter card to reset the CCG2 device; the new firmware image will 

start executing. 
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5.   Kit Operation 

 

 

This chapter describes how to configure the CY4521 EZ-PD CCG2 EVK to demonstrate the functionality as a DRP (Dual Role 
Port) device. Four separate demonstrations are covered. 

 SuperSpeed USB Demo 

 DisplayPort Demo 

 SuperSpeed USB and DisplayPort Demo 

 Dead Battery Demo 

The SuperSpeed USB demonstration provides details for connecting a host (PC) to a client (USB flash drive) through the 
CY4521 EZ-PD CCG2 EVK, also referred to as the “SuperSpeed USB Demo” in this kit guide. The DisplayPort demonstration 
provides details for connecting a host (PC) to a client (display monitor) through the CY4521 EZ-PD CCG2 EVK, also referred 
to as the “DisplayPort Demo” in this kit guide. The “SuperSpeed USB and DisplayPort Demo” is a combined demo of the 
“SuperSpeed USB Demo” and “DisplayPort Demo” using a Type-C multiport adapter. The dead battery demonstration 
emulates a scenario of a notebook with a dead battery, which can be charged by connecting the Type-C power adapter to its 
Type-C port. 

5.1   SuperSpeed USB Demo 

The SuperSpeed USB demo is a full end-to-end demo that demonstrates the following: 

 Type-C connectivity between the DFP (host) and UFP (client) 

 Reversibility of the Type-C connector. 

5.1.1   Boards, Cables, and Accessories Needed 

The following items are needed to perform this demo: 

 Items provided with the kit: 

o 24-V DC power adapter 

o CY4521 EZ-PD CCG2 EVK boards (CCG EVK base board and CCG2 daughter card) 

o USB 3.0 Type-A to Type-B cable  

o USB Type-C to Type-A adapter 

 Items not provided with the kit: 

o USB host device (example: PC) 

o USB flash or disc drive (It is recommended to use a SuperSpeed USB flash drive) 

5.1.2   Running the SuperSpeed USB Demo 

1. Use the default jumper settings shown in Figure 5-1 and Figure 5-2 to configure the CY4521 CCG2 EVK’s base board 
and daughter card.  
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Figure 5-1: CCG EVK Base Board Jumper Settings for SuperSpeed USB Demo 

  

 

Figure 5-2: CCG2 Daughter Card Jumper Settings for SuperSpeed USB Demo 
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2. Use the USB 3.0 Type-A to Type-B cable to connect the CCG EVK base board to the PC. 

3. Connect the 24-V DC power adapter provided with the kit to the CY4521 EZ-PD CCG2 EVK base board’s power jack J1. 
Observe LED2 on the CCG2 daughter card and LED 1 of CCG EVK base board glow green to indicate power is ON, and 
LED2 on CCG EVK base board blinks orange to indicate the CCG firmware is executing. 

4. Connect the USB Type-C to Type-A adapter provided with the CY4521 EZ-PD CCG2 EVK to the Type-C port (J3) of the 
CCG EVK base board. 

5. Plug in a USB drive (not provided with the kit) into the Type-C to Type-A adapter board. Verify your setup as shown in 
Figure 5-3. To evaluate SuperSpeed USB data transfers, it is recommended to use a SuperSpeed USB flash drive. 

Figure 5-3: Setup of SuperSpeed USB Demo Using CY4521 EZ-PD CCG2 EVK 

 

 
6. Observe the enumeration of the USB drive connected to the Type-C to Type-A adapter board on the host PC connected 

via the CY4521 EZ-PD CCG2 EVK. Verify functionality by accessing files on the connected USB drive from the PC. 

7. Disconnect the Type-C to Type-A adapter board and connect it upside down to reconnect the USB drive. 

8. Observe the enumeration of the USB drive connected to the Type-C to Type-A adapter board on the PC connected via 
the CY4521 EZ-PD CCG2 EVK even with the Type-C to Type-A adapter board flipped. Also observe the SuperSpeed 
USB data transfer speed by transferring files. This demonstrates orientation independence of the USB Type-C interface. 

5.1.3   Explanation of Functionality 

By flipping the USB Type-C to Type-A adapter and reconnecting to the setup, we reversed the orientation of the USB data 
channels from the original setup. The reverse order will not affect the enumeration process due to the reversible characteristics 
of Type-C connectors. 

5.1.4   Common Problems and Troubleshooting 

If the demo is not functional, follow these guidelines to troubleshoot. 

1. Ensure that the CY4521 EZ-PD CCG2 EVK’s base board and daughter card are powered by verifying that LED1 on 
the CCG EVK base board and LED2 on the CCG2 daughter card are glowing green and LED2 on the CCG EVK 
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base board is blinking orange. If LED2 on the CCG EVK base board is not blinking, the CCG2 device is not active. 
Assert and release the reset button (SW1) on the CCG2 daughter card. 

2. Ensure that the CCG2 daughter card is mounted properly on the CCG EVK base board; all connections between the 
two boards must be completely mated. 

3. If the SuperSpeed USB device does not enumerate as expected on the PC, unplug the device and then plug it back 
in. 

5.2   DisplayPort Demo 

The DisplayPort demo is a full end-to-end demo that demonstrates the following: 

 Type-C connectivity between the DFP (host) and UFP (client) 

 USB PD Alternate Mode (for DisplayPort): Delivers four-lane DisplayPort video from the host (PC) to client (display 
monitor). 

5.2.1   Boards, Cables, and Accessories Needed 

The following items are needed to perform this demo: 

 Items provided with the kit: 

o 24-V DC power adapter 

o CY4521 EZ-PD CCG2 EVK 

 Items not provided with the kit: 

o DisplayPort video source (example: PC)  

o DisplayPort monitor 

o DisplayPort cable that connects the CCG EVK base board to the PC. If the PC has a Mini DisplayPort plug, use a 
Mini DisplayPort to DisplayPort cable (see the List of Recommended Hardware section) 

o Type-C to DP/HDMI/VGA adapter that connects the CY4521 EZ-PD CCG2 EVK base board to the display monitor 
through the relevant cable (see the List of Recommended Hardware section) 

5.2.2   Running the DisplayPort Demo 

1. Use the default jumper settings shown in Figure 5-1 and Figure 5-2 to configure the CY4521 CCG2 EVK’s base board 
and daughter card.  

2. Mount the CCG2 daughter card on the CCG EVK base board of the CY4521 EZ-PD CCG2 EVK base board if not already 
mounted.  

3. Connect the 24-V DC power adapter provided with the kit to the CY4521 EZ-PD CCG2 EVK base board power jack J1. 
Observe LED2 on the CCG2 daughter card and LED1 of CCG EVK base board glow green to indicate power is ON, and 
LED2 on the CCG EVK base board blinks orange to indicate the CCG firmware is executing. 

4. Connect the Type-C port of Type-C to DP/HDMI/VGA adapter to J3 port (USB Type-C receptacle) of CCG EVK base 
board. Connect its other end to a display monitor that supports the interface using a DisplayPort/HDMI/VGA cable. 

5. Connect the DisplayPort video source (i.e. from the PC) to the CCG EVK base board’s DisplayPort connector J4. 

6. After all connections, your set up should look similar to the setup shown in Figure 5-4. 
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Figure 5-4: Setup of DisplayPort Demo Using CY4521 EZ-PD CCG2 EVK 

 

7. Ensure that the “Extended Display” feature is enabled in the host PC. For Windows users, this feature can be enabled 
by clicking Extended Display, available in the “Control Panel\All Control Panel Items\Display\Connect to a Projector” 
window. For Linux or Mac users, this feature can be enabled by checking the Mirror image option, available in “System 

Preferences (or Settings)\Display”. 

8. Observe that the DisplayPort video is transferred from the host (PC) to the display monitor through the USB Type-C port.  

5.2.3   Common Problems and Troubleshooting 

If the demo is not functional, follow these guidelines to troubleshoot: 

1. Ensure that the CY4521 EZ-PD CCG2 EVK’s base board and daughter card are powered by verifying that LED1 on the 
CCG EVK base board and LED2 on the CCG2 daughter card are glowing green and LED2 on the CCG EVK base board 
is blinking orange. If LED2 on the CCG EVK base board is not blinking, the CCG2 device is not active. Assert and release 
the reset button (SW1) on the CCG2 daughter card. 

2. Ensure that the CCG EVK base board and CCG2 daughter card are powered before connecting the DisplayPort cables. 

3. Ensure that the CCG2 daughter card is mounted properly on the CCG EVK base board. All connections between the two 
boards must be completely mated. 

4. Ensure that “Extended Display” in enabled on the host PC. 

5. If the PC video output is not displayed on the monitor, assert and release the reset button (SW1) on the CCG2 daughter 
card. 

6. While connecting the video output from a Windows 7 (32 bit/64 bit) based PC to a 4K monitor through the CY4521 EVK, 
ensure that the PC uses the latest version of the driver for the Display adapter. Update the driver as required. 

5.3   SuperSpeed USB and DisplayPort Demo 

This demo is a combined demo of the SuperSpeed USB Demo and DisplayPort Demo using a multiport adapter. It 
demonstrates the following: 
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 Type-C connectivity capable of DisplayPort video data and SuperSpeed USB data simultaneously. 

 Type-C connectivity between the DFP (host) and UFP (client). 

 USB PD Alternate Mode (for DisplayPort): Delivers two-lane DisplayPort video from the host (PC) to client (display 
monitor). 

5.3.1   Boards, Cables, and Accessories Needed 

The following items are needed to perform this demo: 

 Items provided with the kit: 

o 24-V DC power adapter 

o CY4521 EZ-PD CCG2 EVK  

o USB 3.0 Type-A to Type-B cable  

 Items not provided with the kit: 

o USB host device and video source (example: PC) 

o Type-C Multiport Adapter that connects the CY4521 EZ-PD CCG2 EVK base board to the display monitor and 
USB flash drive through the relevant cable (see the List of Recommended Hardware section). 

o USB flash or disc drive (It is recommended to use a SuperSpeed USB flash drive) 

o DisplayPort monitor 

o DisplayPort cable that connects the CCG EVK base board to the PC. If the PC has a Mini DisplayPort plug, use a 
Mini DisplayPort to DisplayPort cable (see the List of Recommended Hardware section) 

5.3.2   Running the SuperSpeed USB and DisplayPort Demo 

1. Use the default jumper settings shown in Figure 5-1 and Figure 5-2 to configure the CY4521 EZ-PD CCG2 EVK’s base 
board and daughter card. 

2. Mount the CCG2 daughter card on the CCG EVK base board of the CY4521 EZ-PD CCG2 EVK base board if not already 
mounted. Use the USB 3.0 Type-A to Type-B cable to connect the CCG EVK base board to the PC. 

3. Connect the 24-V DC power adapter provided with the kit to the CY4521 EZ-PD CCG2 EVK base board power jack J1. 
Observe LED2 on the CCG2 daughter card and LED1 of CCG EVK base board glow green to indicate power is ON, and 
LED2 on the CCG EVK base board blinks orange to indicate the CCG firmware is executing. 

4. Connect the Type-C Multiport adapter (not provided with the kit) to J3 USB Type-C receptacle of CCG EVK base board. 
Connect its other end to a display monitor that supports DisplayPort/HDMI/VGA interface. 

5. Plug in a USB drive (not provided with the kit) into the Type-C Multiport adapter. To evaluate SuperSpeed USB data 
transfers, it is recommended to use a SuperSpeed USB flash drive. 

6. Connect the DisplayPort video source (i.e. from the PC) to the CCG EVK base board’s DisplayPort connector J4. 

7. After all connections, your set up should look similar to the setup shown in Figure 5-5. 
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Figure 5-5: Setup of SuperSpeed USB and DisplayPort Demo Using CY4521 EZ-PD CCG2 EVK 

 

8. Ensure that the “Extended Display” feature is enabled in the host PC. For Windows users, this feature can be enabled 
by clicking Extended Display, available in the “Control Panel\All Control Panel Items\Display\Connect to a Projector” 
window. For Linux or Mac users, this feature can be enabled by checking the Mirror image option, available in “System 

Preferences (or Settings)\Display”. 

9. Observe that the DisplayPort video is transferred from the host (PC) to the display monitor through the USB Type-C port. 

10. Also observe the enumeration of the USB drive connected to the Type-C Multiport adapter on the host PC connected via 
the CY4521 EZ-PD CCG2 EVK. Verify functionality by accessing files on the connected USB drive from the PC.  

5.3.3   Common Problems and Troubleshooting 

If the demo is not functional, follow these guidelines to troubleshoot: 

1. Ensure that the CY4521 EZ-PD CCG2 EVK’s base board and daughter card are powered by verifying that LED1 on the 
CCG EVK base board and LED2 on the CCG2 daughter card are glowing green and LED2 on the CCG EVK base board 
is blinking orange. If LED2 on the CCG EVK base board is not blinking, the CCG2 device is not active. Assert and release 
the reset button (SW1) on the CCG2 daughter card. 

2. Ensure that the CCG2 daughter card is mounted properly on the CCG EVK base board. All connections between the two 
boards must be completely mated. 

3. Ensure that the boards are powered before connecting the DisplayPort cables. 

4. Ensure that “Extended Display” in enabled on the host PC. 

5. If the PC video is not displayed on the monitor, assert and release the reset button (SW1) on the CCG2 daughter card.  

6. If the SuperSpeed USB device does not enumerate as expected on the PC, unplug the device and then plug it back in. 
It should enumerate as a SuperSpeed USB device this time. 

7. While connecting the video output from a Windows 7 (32 bit/64 bit) based PC to a 4K monitor through the CY4521 EVK, 
ensure that the PC uses the latest version of the driver for the Display adapters. Update the driver as required. 
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5.4   Dead Battery Demo 

The Dead Battery demo demonstrates the following: 

 Emulates a scenario of a notebook with a dead battery, which can be charged by connecting a Type-C power adapter to 
its Type-C port. 

 Ability of the CCG2 device to perform the power role of a provider as well as a consumer. 

5.4.1   Boards, Cables, and Accessories Needed 

The following items are needed to perform this demo: 

 Items provided with the kit 

o CY4521 EZ-PD CCG2 EVK 

 Items not provided with the kit: 

o Type-C power adapter (see List of Recommended Hardware section) 

o Digital Multimeter to measure voltage 

5.4.2   Running the Dead Battery Demo 

1. Use the default jumper settings shown in Figure 5-1 and Figure 5-2 to configure the CY4521 EZ-PD CCG2 EVK’s base 
board and daughter card. 

2. In order to create a dead battery scenario, do not connect the 24V DC power adapter provided with the kit to the power 
jack J1 of the CCG EVK base board. 

3. Because no power is connected to the EVK setup, the CCG2 device on the CCG2 daughter card is not powered, and 
thus emulates a dead battery scenario on a notebook. The CCG2 device in the EVK can be powered by connecting a 
Type-C power adapter to the Type-C port. As shown in Figure 5-6, connect a Type-C power adapter (not provided with 
the kit. See List of Recommended Hardware section) to Type-C port J3 of the CCG EVK base board. LED2 on the CCG2 
daughter card and LED1 on the CCG EVK base board glow green to indicate power is ON, and LED2 on the CCG EVK 
base board blinks orange to indicate the CCG firmware is executing. 

Figure 5-6: Setup of Dead Battery Demo Using CY4521 EZ-PD CCG2 EVK 

 
 

4. When the CCG2 device in the EVK is powered, it establishes a power contract with the Type-C power adapter and starts 
consuming power. This can be verified by connecting a digital multimeter to the consumer power output header (J7) of 
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the CCG EVK base board to measure the output voltage in the dead battery charging scenario. The output voltage at the 
consumer power output header (J7) is based on the power negotiation between the CCG2 device and the Type-C power 
adapter. Thus, it will vary based on the attached Type-C power adapter. This demonstrates that a CCG2 enabled 
notebook with a Type-C port can be charged from the dead battery condition. 

5.4.3   Power Supply Connections 

A PC/notebook with a USB 3.0 port and a DisplayPort, along with the CY4521 EZ-PD CCG2 EVK, is equivalent to a PD-
enabled Type-C port Notebook as shown in Figure 5-7. In a real Type-C Notebook design, power from the power output 
header (J7) of the CCG EVK base board acting as the power adapter is connected to a Battery Charger Circuit (BCC) of a 
USB 3.0 Notebook/PC. On the CCG4521 EVK setup, the DC power jack J1 on the CCG EVK base board is provided for 
demonstration purposes only because the internal supply from the notebook is not available. In a real system, the DC power 
input header J12 of the CCG EVK base board would be connected to the power system of the notebook. A DC power adapter 
(if required, shown as “Notebook Power Adapter” block in Figure 5-7) would be connected to an “ORing Controller” block 
which supplies power to the Battery Charger Circuit. 

Power being provided to the CY4521 EZ-PD CCG2 EVK setup would come from a PMIC in the Notebook, and the input 
source to that PMIC could be either the notebook battery, a DC power adapter or, a Type-C power adapter.  

Figure 5-7: Type-C Notebook Design Using CY4521 EZ-PD CCG2 EVK 
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The CCG2 daughter card consists of both power provider and power consumer circuitry for the Type-C port. The CCG2 device 
controls this circuitry and decides the source of power for the CCG EVK base board and the CCG2 daughter card. The power 
input header on the CCG EVK base board can receive DC power directly. The power output header on the CCG EVK base 
board can source power directly when a Type-C power adapter is connected to the Type-C port. 

In a CY4521 EZ-PD CCG2 EVK enabled Type-C PC design, the entire EVK can be powered using the following methods: 

Method 1: A DC power adapter is connected to the DC power jack (J1) on CCG EVK base board. In this scenario, the CCG2 

device turns on the power provider control circuitry and power is available on the power input headers.  

Method 2: A Type-C power adapter is connected to the Type-C port. In this scenario, the CCG2 device turns on the power 

consumer control circuitry and power is available on the power output headers.  

5.4.4   Common Problems and Troubleshooting 

If the demo is not functional, follow these guidelines to troubleshoot: 

1. Ensure that the CY4521 EZ-PD CCG2 EVK’s base board and daughter card are powered by verifying that LED1 on the 
CCG EVK base board and LED2 on the CCG2 daughter card are glowing green and LED2 on the CCG EVK base board 
is blinking orange. If LED2 on the CCG EVK base board is not blinking, the CCG2 device is not active. Assert and release 
the reset button (SW1) on the CCG2 daughter card. 

2. Ensure that the CCG2 daughter card is mounted properly on the CCG EVK base board. All connections between the two 
boards must be completely mated. 

3. Ensure that the I/O Supply Selection jumper (J3) of the CCG2 daughter card is set to its default setting (2-3 short as 
shown in Figure 3-5). 

4. If there is no voltage at jumper J7 of the CCG EVK base board, verify the connection of the Type-C Power Adapter to the 
CCG EVK base board. Also ensure that the connected Type-C power adapter supports a 5V to 20V power profile. 
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6.   Appendix  

 

6.1   Terminology 

This guide assumes that the user of the CY4521 EZ-PD CCG2 EVK is familiar with the fundamentals of Type-C connectivity 
and the USB Power Delivery protocol. A brief description of Type-C terms is provided here for reference. 

 Alternate Modes: A feature of a USB Type-C system whereby one or both of the SuperSpeed lanes may be repurposed 
for use with a different serial protocol, such as a DisplayPort, eSATA, or Thunderbolt. 

 Client: A USB peripheral such as a hub, docking station, or monitor. 

 Configuration channel (CC): A USB Type-C bus wire used to transmit protocol signals. This is a half-duplex 300-kHz 
signal.  

 Consumer: A Type-C port that sinks power from VBUS. 

 DisplayPort: A digital display interface standard developed by the Video Electronics Standards Association. It is used 
primarily to connect a video source to a display such as a computer monitor. 

 Downstream facing port (DFP): A USB Type-C port on a host or a hub to which devices are connected.  

 Dp, Dn: USB Type-C bus wires used to transmit and receive USB 2.0 data. 

 Dual-role port (DRP): A USB Type-C port that can operate as either a DFP or a UFP. 

 Electronically Marked Cable Assembly (EMCA): A USB cable that includes an IC that reports cable characteristics (such 
as current rating) to the Type-C ports.  

GNDRX2pRX2nVBUSDnCC SBU1DpVBUSTX1nTX1pGND

GNDTX2pTX2nVBUSSBU2 VCONNVBUSRX1nRX1pGND

B1B2B3B4B5B8B9B10B11B12

A12A11A10A9A8A7A6A5A4A3A2A1

2.4mm
2.5mm

GNDRX2pRX2nVBUSDn1CC1 SBU1Dp1VBUSTX1nTX1pGND

GNDTX2pTX2nVBUSSBU2 CC2VBUSRX1nRX1pGND

B1B2B3B4B5B8B9B10B11B12

A12A11A10A9A8A7A6A5A4A3A2A1

Dp2Dn2

B6B7

USB3.0 Type-C Plug USB3.0 Type-C Receptacle

 
 Host: A USB Host system such as a PC, notebook, and laptop.  

 Provider: A Type-C port that sources power over VBUS.  

 Sideband use (SBU): A USB Type-C bus wire used for non-USB control signals, such as DisplayPort control signals. 

 Type-C Transceiver: A transmitter/receiver that communicates over the CC. 

 TX1p, TX1n, RX1p, RX1n, TX2p, TX2n, RX2p, and RX2n: USB Type-C bus wires used to transmit and receive 
SuperSpeed USB and PCIe or DisplayPort data. 

 Upstream facing port (UFP): A USB Type-C port on a device or a hub that connects to a host or the DFP of a hub. 

 USB Power Delivery (USB PD, PD): A new USB standard that increases maximum power delivery over USB from 7.5 W 
to 100 W. 

 USB Type-C (Type-C): A new standard with a slimmer USB connector and a reversible cable, capable of sourcing up to 
100 W of power and supporting Alternate Modes. 

 VBUS: A USB Type-C bus wire used for power; initially 5 V, but can be increased up to 20 V on USB PD systems. 

 VCONN: A USB Type-C bus wire used to power the IC in the EMCA. 
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6.2   CCG EVK Base Board 

6.2.1   Schematics 

 



   Appendix 

CY4521 EZ-PD™ CCG2 Evaluation Kit Guide, Doc. No. 002-15712 Rev. *A 43 



   Appendix 

CY4521 EZ-PD™ CCG2 Evaluation Kit Guide, Doc. No. 002-15712 Rev. *A 44 



   Appendix 

CY4521 EZ-PD™ CCG2 Evaluation Kit Guide, Doc. No. 002-15712 Rev. *A 45 



   Appendix 

CY4521 EZ-PD™ CCG2 Evaluation Kit Guide, Doc. No. 002-15712 Rev. *A 46 

 

 

  



   Appendix 

CY4521 EZ-PD™ CCG2 Evaluation Kit Guide, Doc. No. 002-15712 Rev. *A 47 

6.2.2   Gerber Files 
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6.2.3   Bill of Materials 

Item Qty Reference Value Description Manufacturer Mfr Part Number 

1 1 N/A 600-
60271-01 

PCB, BARE, CCG EVK Base 
Board  

Cypress 
Approved 
Manufacturer 

600-60271-01 

2 2 C25,C26 0.01uF CAP CER 10000PF 25V 10% X7R 
0402 

AVX Corporation 04023C103KAT2
A 

3 15 C27,C28,C29,C31,C34,C
42,C44,C46,C52,C54,C6
3,C64,C65,C70,C71 

0.1uF CAP CER 0.1UF 10V 10% X7R 
0402 

TDK Corporation C1005X7R1A104
K050BB 

4 4 C36,C37,C38,C39 0.22uF CAP CER 0.22UF 16V X7R 0402 Yageo CC0402KRX7R7
BB224 

5 3 C14,C50,C59 10uF CAP CER 10UF 50V X7R 1210 Murata 
Electronics 
North America 

GRM32ER71H10
6KA12L 

6 3 C33,C45,C51 1uF CAP CER 1UF 10V X5R 0402 Murata 
Electronics 
North America 

GRM155R61A10
5KE15D 

7 2 C61,C72 1uF CAP CER 1UF 35V X7R 0603 TDK Corporation C1608X7R1V105
K080AC 

8 1 C35 2.2uF CAP CER 2.2UF 25V 10% X5R 
0603 

TDK Corporation C1608X5R1E225
K080AB 

9 3 C32,C40,C74 2200pF CAP CER 2200PF 2KV 10% X7R 
1808 

Johanson 
Dielectrics Inc. 

202R29W222KV4
E 

10 3 C8,C47,C48 22uF CAP CER 22UF 10V X5R 0805 Murata 
Electronics 
North America 

GRM219R61A22
6MEA0D 

11 3 C12,C41,C43 4.7uF CAP CER 4.7UF 10V 20% X5R 
0402 

TDK Corporation C1005X5R1A475
M050BC 

12 2 C49,C62 0.1uF CAP CER 0.1UF 50V 10% JB 
0603 

TDK Corporation C1608JB1H104K
080AA 

13 1 C30 4.7uF CAP CER 4.7UF 50V X7R 1210 Murata 
Electronics 
North America 

GRJ32ER71H475
KE11L 

14 2 C116,C118 0.1uF CAP CER 0.1UF 50V 10% X5R 
0402 

TDK Corporation C1005X5R1H104
K050BB 

15 1 C120 0.1uF CAP CER 0.1UF 25V 10% X7R 
0603 

Murata 
Electronics 
North America 

GRM188R71E10
4KA01D 

16 1 C121 0.47uF CAP CER 0.47UF 50V 10% X7R 
0603 

TDK Corporation C1608X7R1H474
K080AC 

17 1 C117 1uF CAP CER 1UF 50V 10% X5R 
0603 

TDK Corporation C1608X5R1H105
K080AB 

18 1 C141 270pF Capacitor, 270pF, 50V, 5%, NPO, 
0402 

Murata 
Electronics 
North America 

GRM1555C1H27
1JA01D 

19 3 C119,C123, C124 330uF CAP ALUM 330UF 50V 20% SMD Panasonic 
Electronic 
Components 

EEE-FT1H331AP 

20 1 C140 470pF Capacitor, 470pF, 50V, 10%, X7R, 
0603 

Murata 
Electronics 
North America 

GRM188R71H47
1KA01D 

21 1 C122 8.2nF CAP CER 8200PF 50V 10% X7R 
0402 

Kemet C0402C822K5RA
CTU 

22 3 D4,D6,D9 PMEG30
50BEP,11
5 

DIODE SCHOTTKY 30V 5A 
SOD128 

NXP 
Semiconductors 

PMEG3050BEP,1
15 
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Item Qty Reference Value Description Manufacturer Mfr Part Number 

23 1 D8 1N4148W
FL-G3-08 

DIODE GP 75V 150MA 
SOD123FL 

Vishay 
Semiconductor 
Diodes Division 

1N4148WFL-G3-
08 

24 1 D10 SMBJ24A
-TR 

TVS DIODE 24VWM 50VC 
DO214AA 

STMicroelectroni
cs 

SMBJ24A-TR 

25 6 D11,D12,D13,D14,D16,D
17 

ESD105B
102EL 

TVS DIODE 5.5VWM 14VC 
TSLP2-2 

Infineon 
Technologies 

ESD105B102ELE
6327XTMA1 

26 1 D15 SMBJ24C
A-E3/52 

TVS DIODE 24VWM 38.9VC SMB Vishay 
Semiconductor 
Diodes Division 

SMBJ24CA-
E3/52 

27 1 D19 MMSZ47
02T1G 

Diode, Zener, 15V, 0.5W, SOD123 On 
Semiconductor 

MMSZ4702T1G 

28 1 D20 MBR0540
T1G 

DIODE SCHOTTKY 40V 0.5A 
SOD123 

On 
Semiconductor 

MBR0540T1G 

29 1 D21 MMSD70
1T1G 

Diode, Shottky, 70V, 0.2A, 
SOD123 

On 
Semiconductor 

MMSD701T1G 

30 1 J1 69410630
1002 

CONN PWR JACK DC RIGHT 
ANGLE THROUGH HOLE 

Wurth 
electronics 

694106301002 

31 1 J2 UEB1112
C-2AK1-
4H 

Connector Receptacle USB TypeB 
3.0, Super Speed 9 Position 
Through Hole, Right Angle, 
Horizontal 

Foxconn UEB1112C-
2AK1-4H 

32 1 J3 DX07S02
4JJ2R130
0 

USB TYP C TP MNT DL RW SMT 
RECEP 

JAE Electronics DX07S024JJ2R1
300 

33 1 J4 47272000
1 

Connector Receptacle DisplayPort 
20 Position Surface Mount, Right 
Angle, Horizontal 

Molex, LLC 472720001 

34 1 J5 54819051
9 

Connector Receptacle USB - mini 
B 2.0 OTG 5 Position Through 
Hole, Right Angle, Horizontal 

Molex, LLC 548190519 

35 1 J7 1935161 TERM BLOCK PCB 2POS 5.0MM 
GREEN 

Phoenix Contact 1935161 

36 1 J8 SFH11-
PBPC-
D20-ST-
BK 

Connector Header 40 Position 
0.100" (2.54mm) Gold Through 
Hole 

Sullins 
Connector 
Solutions 

SFH11-PBPC-
D20-ST-BK 

37 1 J9 SBH11-
PBPC-
D12-ST-
BK 

CONN HEADER VERT 24POS 
GOLD 

Sullins 
Connector 
Solutions 

SBH11-PBPC-
D12-ST-BK 

38 1 J11 961102-
6404-AR 

CONN HEADER VERT SGL 
2POS GOLD 

3M 961102-6404-AR 

39 1 J12 OSTTC02
0162 

TERMINAL BLOCK 5MM VERT 
2POS PCB 

On Shore 
Technology Inc. 

OSTTC020162 

40 1 L1 1uH FIXED IND 1UH 1.8A 48 MOHM 
SMD 

Murata 
Electronics 
North America 

LQM32PN1R0M
G0L 

41 1 L3 10uH FIXED IND 10UH 9A 25.5 MOHM 
SMD 

Bourns Inc. SRP1245A-100M 

42 2 L4,L5 220Ohm
@100MH
z 

FERRITE BEAD 220 OHM 0603 
1LN 2.2A 

TDK Corporation MPZ1608S221A 

43 1 L6 4.7uH FIXED IND 4.7UH 2A 72 MOHM 
SMD 

Bourns Inc. SRN5020-4R7M 

44 1 LED1 GREEN LED GREEN CLEAR 0603 SMD Lite-On Inc. LTST-C190GKT 

45 1 LED2 ORANGE LED ORANGE CLEAR 0603 SMD Lite-On Inc. LTST-C190KFKT 

46 2 Q3,Q4 2N7002D
W-7-F 

MOSFET 2N-CH 60V 0.23A SOT-
363 

Diodes 
Incorporated 

2N7002DW-7-F 
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Item Qty Reference Value Description Manufacturer Mfr Part Number 

47 2 Q1,Q2 2N7002L
T1G 

Transistor, 2N7002, N-Channel 
MOS-FET, 60V, 115mA, SOT-23 

ON 
Semiconductor 

2N7002LT1G 

48 1 Q5 MMBT39
04LT1 

TRANS NPN 40V 0.2A SOT23 On 
Semiconductor 

MMBT3904LT1G 

49 1 Q6 NTMFS5
834NL 

MOSFET N-CH 40V 13A SO-8FL On 
Semiconductor 

NTMFS5834NLT
1G 

50 1 Q7 NTTFS58
26NL 

MOSFET N-CH 60V 8A 8-WDFN On 
Semiconductor 

NTTFS5826NLTA
G 

51 4 R111,R124,R166,R168 0E RES SMD 0.0OHM JUMPER 
1/10W 0603 

Panasonic 
Electronic 
Components 

ERJ-3GEY0R00V 

52 7 R9,R22,R25,R61,R73,R7
7,R162 

0E RES 0.0 OHM 1/16W JUMP 0402 
SMD 

Vishay Dale CRCW04020000
Z0ED 

53 13 R30,R31,R32,R33,R34,R
35,R41,R47,R60,R64,R6
6,R67,R81 

100K RES SMD 100K OHM 5% 1/10W 
0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ104X 

54 1 R74 10K RES 10K OHM 1/16W 1% 0402 Samsung 
Electro-
Mechanics 
America, Inc 

RC1005F103CS 

55 1 R58 16K RES SMD 16K OHM 1% 1/16W 
0402 

Yageo RC0402FR-
0716KL 

56 1 R56 1K RES SMD 1K OHM 1% 1/10W 
0402 

Panasonic 
Electronic 
Components 

ERJ-2RKF1001X 

57 1 R57 1K RES SMD 1K OHM 5% 1/2W 0805 Panasonic 
Electronic 
Components 

ERJ-P06J102V 

58 2 R46,R51 1M RES SMD 1M OHM 1% 1/10W 
0603 

Yageo RC0603FR-
071ML 

59 2 R36,R37 2K RES SMD 2K OHM 5% 1/16W 
0402 

Yageo RC0402JR-
072KL 

60 1 R70 30K RES SMD 30K OHM 1% 1/16W 
0402 

Yageo RC0402FR-
0730KL 

61 1 R7 330E RES SMD 330 OHM 5% 1/10W 
0603 

Yageo RC0603JR-
07330RL 

62 2 R38,R40 4.7K RES SMD 4.7K OHM 5% 1/16W 
0402 

Yageo RC0402JR-
074K7L 

63 1 R53 4.99K RES SMD 4.99K OHM 1% 1/10W 
0402 

Panasonic 
Electronic 
Components 

ERJ-2RKF4991X 

64 1 R59 5.1K RES SMD 5.1K OHM 1% 1/16W 
0402 

Yageo RC0402FR-
075K1L 

65 1 R29 1.13K RES SMD 1.13K OHM 1% 1/16W 
0402 

Stackpole 
Electronics Inc. 

RMCF0402FT1K
13 

66 1 R28 1.5K RES SMD 1.5K OHM 1% 1/10W 
0402 

Panasonic 
Electronic 
Components 

ERJ-2RKF1501X 

67 1 R169 16.5K RES SMD 16.5K OHM 1% 1/10W 
0603 

Stackpole 
Electronics Inc. 

RMCF0603FT16
K5 

68 1 R27 2.67K RES SMD 2.67K OHM 1% 1/16W 
0402 

Yageo RC0402FR-
072K67L 

69 1 R24 30E RES SMD 30 OHM 1% 1/16W 
0402 

Yageo RC0402FR-
0730RL 

70 1 R26 5.49K RES SMD 5.49K OHM 1% 1/16W 
0402 

Yageo RC0402FR-
075K49L 

71 1 R23 60.4E RES SMD 60.4 OHM 1% 1/16W 
0402 

Yageo RC0402FR-
0760R4L 
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Item Qty Reference Value Description Manufacturer Mfr Part Number 

72 1 R176 100E RES SMD 100 OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF1000V 

73 6 R109,R113,R118,R125,R
164,R170 

10K RES SMD 10K OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF1002V 

74 1 R112 14.3K RES SMD 14.3K OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF1432V 

75 1 R115 100K 100k Ohm ±1% 0.1W, 1/10W 
Surface Mount Resistor Thick Film 
±100ppm/°C 0603 

Yageo RC0603FR-
07100KL 

76 1 R123 16.9K RES SMD 16.9K OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF1692V 

77 2 R165,R182 1K RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF1001V 

78 1 R179 20E RES SMD 20 OHM 5% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3GEYJ200V 

79 3 R129,R167,R174 20K RES SMD 20K OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF2002V 

80 1 R108 300E RES SMD 300 OHM 5% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3GEYJ301V 

81 1 R110 5.1E RES SMD 5.1 OHM 5% 1/10W 
0603 

Vishay Dale CRCW06035R10
JNEA 

82 1 R172 5.1K RES SMD 5.1K OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF5101V 

83 1 R127 619E RES SMD 619 OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF6190V 

84 1 SW1 EVQ-
PE105K 

SWITCH TACTILE SPST-NO 
0.05A 12V 

Panasonic 
Electronic 
Components 

EVQ-PE105K 

85 1 U2 TPS6125
3 

IC REG BOOST 5V 3.3A SYNC 
9DSBGA 

Texas 
Instruments 

TPS61253YFFR 

86 1 U3 NCP1034 IC, PWM Buck Controller, 100V, 
NCP1034, SOIC16 

On 
Semiconductor 

NCP1034DR2G 

87 1 U4 CD74HC
238PWR 

IC DECODER/DEMUX HS 3-8 16-
TSSOP 

Texas 
Instruments 

CD74HC238PWR 

88 1 U5 PS8740B USB Type-C Redriving Switch for 
USB Host / DisplayPort Source 

Parade 
Technologies 
Ltd 

PS8740B 

89 1 U6 CY7C652
15 

IC USB TO UART BRIDGE DUAL 
32QFN 

Cypress 
Semiconductor 

CY7C65215-
32LTXI 

90 1 U7 USBLC6-
2P6 

TVS DIODE 5.25VWM 17VC 
SOT666 

STMicroelectroni
cs 

USBLC6-2P6 

91 1 U13 RT8299A
ZSP 

IC REG BUCK ADJ 3A SYNC 
8SOP 

Richtek USA 
Inc. 

RT8299AZSP 

92 1 U14 L78L05A
BUTR 

IC REG LDO 5V 0.1A SOT89-3 STMicroelectroni
cs 

L78L05ABUTR 

93 1 U15 TS3704IP
T 

IC COMP QUAD CMOS 
MCRPWR 14TSSOP 

STMicroelectroni
cs 

TS3704IPT 
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Item Qty Reference Value Description Manufacturer Mfr Part Number 

94 5 V3P3,V5P0,USB_P_PW
R,USB_C_PWR,TYPE-
C_VBUS 

RED TEST POINT PC MINI .040"D 
RED 

Keystone 
Electronics 

5000 

95 4 GND1,GND2,GND3,GND
4 

BLACK TEST POINT PC MINI .040"D 
BLACK 

Keystone 
Electronics 

5001 

MISC components 

96 4 Bumper NA BUMPER CYLIN 0.312" DIA BLK 3M SJ61A6 

97 1 Type-C Clamping Bracket NA Type-C Connector Bracket Global 
Technology 
Services 

Type-C 
Connector 
Clamping Bracket 

98 2 M2x5mm Screws NA SCREW, Pan Head, machined 
screws, M2 x 5mm 

  

99 1 Jumper Plug NA 2.54MM JUMPER PLUG WITH 
TEST POINT 

Wurth 
Electronics 

609002115121 

100 1 Label NA LBL, PCA Identification Label, 
Vendor Code, Datecode, Serial 
Number(YYWWVVXXXX) 

Cypress 
Semiconductor 

 

No load components     

101 1 D18 PMEG30
50BEP,11
5 

DIODE SCHOTTKY 30V 5A 
SOD128 

NXP 
Semiconductors 

PMEG3050BEP,1
15 

102 1 J6 302-S101 10 Positions Header, Shrouded 
Connector 0.100" (2.54mm) 
Through Hole Gold 

On Shore 
Technology Inc. 

302-S101 

103 1 J10 M20-
9990445 

4 Positions Header, Unshrouded, 
Breakaway Connector 0.100" 
(2.54mm) Through Hole Gold 

Harwin Inc. M20-9990445 

104 5 R39,R54,R55,R79,R80 0E RES 0.0 OHM 1/16W JUMP 0402 
SMD 

Vishay Dale CRCW04020000
Z0ED 

105 2 R75,R76 2K RES SMD 2K OHM 5% 1/16W 
0402 

Yageo RC0402JR-
072KL 

106 8 R42,R43,R44,R45,R48,R
49,R50,R52 

4.7K RES SMD 4.7K OHM 5% 1/16W 
0402 

Yageo RC0402JR-
074K7L 

107 1 R65 10K RES 10K OHM 1/16W 1% 0402 Samsung 
Electro-
Mechanics 
America, Inc 

RC1005F103CS 

108 1 R68 100K RES SMD 100K OHM 5% 1/10W 
0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ104X 

109 1 R177 5.49K RES SMD 5.49K OHM 1% 1/10W 
0603 

Panasonic 
Electronic 
Components 

ERJ-3EKF5491V 

110 3 TP11,TP12,VCONN_MO
N 

YELLOW TEST POINT PC MINI .040"D 
YELLOW 

Keystone 
Electronics 

5004 

111 3 Vfb,V_SYS,DP_PWR RED TEST POINT PC MINI .040"D 
RED 

Keystone 
Electronics 

5000 
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6.3   CCG2 EVK Daughter Card 

6.3.1   Schematics 
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6.3.2   Gerber Files 
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6.3.3   Bill of Materials 

# Qty Reference Value Description Manufacturer Mfr Part # 

1 1 C1 10pF CAP CER 10PF 25V 5% 
NP0 0402 

Kemet C0402C100J3G
ACTU 

2 4 C11,C14,C15,C29 1uF CAP CER 1UF 10V X5R 
0402 

Murata Electronics 
North America 

GRM155R61A1
05KE15D 

3 6 C12,C13,C19,C26,C
28,C30 

0.1uF CAP CER 0.1UF 50V X7R 
0402 

Murata Electronics 
North America 

GRM155R71H1
04ME14D 

4 1 C18 0.1uF CAP CER 0.1UF 16V X7R 
0603 

Samsung Electro-
Mechanics 
America, Inc. 

CL10B104MO8
NNNC 

5 1 C2 10uF CAP CER 10UF 50V X7R 
1210 ±10% 

Samsung Electro-
Mechanics 
America, Inc. 

CL32B106KBJ
NNWE 

6 1 C21 4.7uF CAP CER 4.7UF 35V X5R 
0603 

Murata Electronics 
North America 

ZRB18AR6YA4
75KE05L 

7 1 C22 10nF CAP CER 10000PF 50V 
X7R 0603 

Samsung Electro-
Mechanics 
America, Inc. 

CL10B103KB8
NCNC 

8 1 C3 4.7uF CAP CER 4.7UF 50V X7R 
1210 

Murata Electronics 
North America 

GRJ32ER71H4
75KE11L 

9 1 C32 2200pF CAP CER 2200PF 2KV 10% 
X7R 1808 

Johanson 
Dielectrics Inc. 

202R29W222K
V4E 

10 1 C5 22uF CAP CER 22UF 10V X5R 
0603 

Samsung Electro-
Mechanics 
America, Inc. 

CL10A226MP8
NUNE 

11 3 C6,C16,C27 4.7uF CAP CER 4.7UF 10V 20% 
X5R 0402 

TDK Corporation C1005X5R1A4
75M050BC 

12 2 C7,C8 390pF CAP CER 390PF 50V X7R 
0402 

Murata Electronics 
North America 

GRM155R71H3
91KA01D 

13 3 C9,C10,C31 0.1uF CAP CER 0.1UF 10V 10% 
X7R 0402 

TDK Corporation C1005X7R1A1
04K050BB 

14 3 D1,D2,D3 RB521S30 DIODE SCHOTTKY 30V 
200MA SOD523F 

Fairchild 
Semiconductor 

RB521S30 

15 1 J1 22232051 CONN HEADER 5POS .100 
VERT TIN 

Molex, LLC 22232051 

16 2 J2,J3 CON3 CONN HEADER .100" 
SNGL STR 3POS 

Sullins Connector 
Solutions 

PRPC003SAAN
-RC 

17 1 J4 SBH11-
PBPC-
D20-ST-
BK 

40 Positions Header, 
Shrouded Connector 0.100" 
(2.54mm) Through Hole 
Gold 

Sullins Connector 
Solutions 

SBH11-PBPC-
D20-ST-BK 

18 1 J5 54819051
9 

Connector Receptacle USB 
- mini B 2.0 OTG 5 Position 
Through Hole, Right Angle, 
Horizontal 

Molex, LLC 548190519 

19 1 LED1 RED LED RED CLEAR 0603 
SMD 

Lite-On Inc. LTST-C190EKT 

20 1 LED2 GREEN LED GREEN CLEAR 0603 
SMD 

Lite-On Inc. LTST-
C190GKT 

21 3 Q1,Q3,Q4 2N7002D
W-7-F 

MOSFET 2N-CH 60V 0.23A 
SOT-363 

Diodes 
Incorporated 

2N7002DW-7-F 
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# Qty Reference Value Description Manufacturer Mfr Part # 

22 2 Q2,Q5 SI7997DP-
T1-GE3 

MOSFET 2P-CH 30V 60A 
PPAK SO-8 

Vishay Siliconix SI7997DP-T1-
GE3 

23 1 Q6 NTZD3152
PT1G 

MOSFET 2P-CH 20V 0.43A 
SOT-563 

ON 
Semiconductor 

NTZD3152PT1
G 

24 1 Q7 IRLML640
1TRPBF 

MOSFET P-CH 12V 4.3A 
SOT-23 

Infineon 
Technologies 
Americas Corp. 

IRLML6401TRP
BF 

25 1 Q8 IRLML930
3TRPBF 

MOSFET P-CH 30V 2.3A 
SOT-23-3 

International 
Rectifier 

IRLML9303TRP
BF 

26 1 Q9 SI2300DS-
T1-GE3 

MOSFET N-CH 30V 3.6A 
SOT-23 

Vishay Siliconix SI2300DS-T1-
GE3 

27 7 R1,R11,R12,R14,R3
9,R40,R50 

10K RES 10K OHM 1/16W 1% 
0402 

Samsung Electro-
Mechanics 
America, Inc 

RC1005F103C
S 

28 3 R13,R36,R47 100K RES SMD 100K OHM 1% 
1/16W 0402 

Yageo RC0402FR-
07100KL 

29 16 R16,R18,R21,R24,R
25,R30,R42,R67,R6
9,R71,R75,R76,R80,
R85,R94,R95 

0E RES 0.0 OHM 1/16W JUMP 
0402 SMD 

Vishay Dale CRCW0402000
0Z0ED 

30 2 R2,R9 330E RES SMD 330 OHM 5% 
1/10W 0603 

Yageo RC0603JR-
07330RL 

31 6 R3,R17,R56,R66,R6
8,R72 

4.7K RES SMD 4.7K OHM 5% 
1/16W 0402 

Yageo RC0402JR-
074K7L 

32 1 R32 1K RES SMD 1K OHM 1% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-
2RKF1001X 

33 1 R33 453K RES SMD 453K OHM 1% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-
2RKF4533X 

34 1 R38 75K RES SMD 75K OHM 1% 
1/16W 0402 

Yageo RC0402FR-
0775KL 

35 1 R4 3.3K RES SMD 3.3K OHM 5% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ332X 

36 1 R43 22K RES SMD 22K OHM 5% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ223X 

37 4 R45,R46,R63,R90 100K RES SMD 100K OHM 5% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ104X 

38 1 R48 49.9K RES SMD 49.9K OHM 1% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-
2RKF4992X 

39 1 R49 200E RES SMD 200 OHM 1% 3W 
2512 

TE Connectivity 
AMP Connectors 

3522200RFT 

40 4 R5,R7,R10,R54 10E RES SMD 10 OHM 1% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-
2RKF10R0X 

41 2 R58,R61 200K 200k Ohm ±1% 0.1W, 
1/10W 0603 

Yageo RC0603FR-
07200KL 

42 2 R59,R60 100K 100k Ohm ±1% 0.1W, 
1/10W 0603 

Yageo RC0603FR-
07100KL 
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# Qty Reference Value Description Manufacturer Mfr Part # 

43 1 R6 10m RES SMD 0.01 OHM 1% 
2W 2512 

Rohm 
Semiconductor 

PMR100HZPF
U10L0 

44 1 SW1 EVQ-
PE105K 

SWITCH TACTILE SPST-
NO 0.05A 12V 

Panasonic 
Electronic 
Components 

EVQ-PE105K 

45 1 TYPE-C_VBUS RED TEST POINT PC MINI 
.040"D RED 

Keystone 
Electronics 

5000 

46 1 U1  
ZXCT1109 

IC CURR MONITOR HIGH 
SIDE SOT23 

Diodes 
Incorporated 

ZXCT1109SA-7 

47 1 U2 AP2822AK
ATR-G1 

IC USB POWER SWITCH 
SOT25 

Diodes 
Incorporated 

AP2822AKATR
-G1 

48 1 U3 CYPD212
2-24LQXIT 

IC MCU 32BIT 32KB FLASH 
24QFN 

Cypress 
Semiconductor 

CYPD2122-
24LQXIT 

49 1 U4 TSX3702I
Q2T 

IC COMPARATOR 16V 
DUAL CMOS 8DFN 

STMicroelectronic
s 

TSX3702IQ2T 

50 1 U6 CY7C6521
5 

IC USB TO UART BRIDGE 
DUAL 32QFN 

Cypress 
Semiconductor 
Corp 

CY7C65215-
32LTXI 

51 1 U7 USBLC6-
2P6 

TVS DIODE 5.25VWM 
17VC SOT666 

STMicroelectronic
s 

USBLC6-2P6 

52 1 N/A 600-
60361-01 

PCB, BARE, CY4521 CCG2 
Daughter Card  

Cypress Approved 
Manufacturer 

600-60361-01 

MISC Components 

53 1 Jumper Plug N/A 2.54MM JUMPER PLUG 
WITH TEST POINT 

Wurth Electronics 
Inc 

609002115121 

54 1 Label NA LBL, PCBA Identification Label Cypress 
Semiconductor 

 

NO LOAD Components 

55 
1 C4 4.7uF 

CAP CER 4.7UF 50V X7R 
1210 

Murata Electronics 
North America 

GRJ32ER71H4
75KE11L 

56 
3 C17,C23,C33 0.1uF 

CAP CER 0.1UF 16V X7R 
0603 

Samsung Electro-
Mechanics 
America, Inc. 

CL10B104MO8
NNNC 

57 
2 C20,C24 4.7uF 

CAP CER 4.7UF 35V X5R 
0603 

Murata Electronics 
North America 

ZRB18AR6YA4
75KE05L 

58 
1 C25 10uF 

CAP CER 10UF 50V X7R 
1210 ±10% 

Samsung Electro-
Mechanics 
America, Inc. 

CL32B106KBJ
NNWE 

59 

16 

R8,R15,R22,R23,R2
6,R27,R28,R29,R31,
R35,R51,R57,R62,R
65,R73,R74 

0E 
RES 0.0 OHM 1/16W JUMP 
0402 SMD 

Vishay Dale 
CRCW0402000
0Z0ED 

60 
5 

R19,R20,R37,R41,R
70 

10K 
RES 10K OHM 1/16W 1% 
0402 

Samsung Electro-
Mechanics 
America, Inc 

RC1005F103C
S 

61 
1 R34 453K 

RES SMD 453K OHM 1% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-
2RKF4533X 
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Document Revision History 

Document Title: CY4521 EZ-PD™ CCG2 Evaluation Kit Guide 

Document Number: 002-15712  

Revision Issue Date Origin of 

Change 

Description of Change 

** 11/25/2016 VGT New EVK user guide. 

*A 01/04/2017 SELV Added CE compliance details. 

Updates to address the feedback received on the Beta version of the document 
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